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Outline

● History
● Geant4 analysis tools

● Histogram, ntuples, analysis commands

● Plotting With External analysis tools
● ROOT, Gnuplot, Excel, Open[Libre]Office, OpenScientist, ...

● Interfacing With External Analysis Tools
● ROOT, AIDA
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History

● Historically first analysis tools in Geant4 examples
● Based on AIDA = Abstract Interfaces for Data Analysis

● First provided within the Geant4 example extended/analysis/AnaEx01 
(jas, Lab), then available as external tools

● The AIDA compliant tools (linked in the Geant4 Guide for Application 
Developers):

– JAS, iAIDA, Open Scientist Lab, rAIDA

● Not all kept maintained, not all implement the AIDA interfaces completely

● Not always easy to be installed & used

– See Geant4 user forum, Analysis category

● Still supported with Geant4 9.6 (November 2012)
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New Analysis Tools

● New analysis category in Geant4 since Geant4 9.5 (December 
2011) 

● Based on g4tools from inlib/exlib  developed by G. Barrand 
(LAL):

● http://inexlib.lal.in2p3.fr/

● “Pure header code” - all code is inlined

● Can be installed on iOS, Android, UNIXes, Windows

● Provides code to write histograms and “flat ntuples” in several formats: 
ROOT, XML AIDA format, CSV for ntuples. HBOOK

● Complete migration to g4tools in all Geant4 examples is in the 
development plan for 2013

http://inexlib.lal.in2p3.fr/
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Analysis Managers

Provide 
● Uniform interface to g4tools

● Hide the differences according to a selected 
technology (root, XML, HBOOK) from the user

● Higher level management of g4tools 
objects (file, histograms, ntuples)

● Memory management

● Access to histograms, ntuple columns via 
indexes

● Integration in the Geant4 framework
● Interactive commands, Units

G4VAnalysis
Manager

G4CsvAnalysis
Manager

G4RootAnalysis
Manager

G4XmlAnalysis
Manager

EG4HbookAnalysis
Manager
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Histograms

#ifndef B4Analysis_h
#define B4Analysis_h 1

#include "g4root.hh"
//#include "g4xml.hh"
//#include "g4hbook.hh"

#endif

B4Analysis.hh

B4RunAction.cc

#include "B4Analysis.hh"

void B4RunAction::BeginOfRunAction(const G4Run* run) 
{ 
  // Get analysis manager
  G4AnalysisManager* man = G4AnalysisManager::Instance();
  

  // Open an output file
  man->OpenFile("exampleB4");

  // Create histogram(s)
  man->CreateH1("0","Edep in absorber", 100, 0., 800*MeV);
  man->CreateH1("1","Edep in gap", 100, 0., 100*MeV);
}

void B4RunAction::EndOfRunAction(const G4Run* aRun)
{
  G4AnalysisManager* man = G4AnalysisManager::Instance();
  man->Write();
  man->CloseFile();
}

B4EventAction.cc

#include "B4Analysis.hh"

void N4EventAction::EndOfEventAction(const G4Run* aRun)
{
  G4AnalysisManager* man = G4AnalysisManager::Instance();
  man->FillH1(0, fEnergyAbs);
  man->FillH1(1, fEnergyGap);
}

Selection of the output format
at a single place

Histogram IDs are attributed 
Automatically
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More On Histograms

● Histogram Identifiers
● The histogram ID is automatically generated when a histogram is 

created by G4AnalysisManager::CreateH1(), and its value is returned 
from this function. 

– The histogram names ("0", "1") have no relation to the histogram ID which is 
used afterwords in histograms fill. 

● The default start value 0 can be changed (eg. to 1) with the 
G4AnalysisManager->SetFirstHistoId(G4int) method.

● The 1D and 2D histigrams IDs are defined independently

● Histogram Objects
● It is also possible to access directly the histogram by 

G4AnalysisManager::GetH1(G4int id). The concrete histogram type is 
hidden behind a selected namespace

    G4cout << "\n ----> print histograms statistic \n" << G4endl;
    G4cout << " EAbs : mean = " << analysisManager->GetH1(1)->mean() 
                << " rms = " << analysisManager->GetH1(1)->rms() << G4endl;
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Activation Of Histograms

● The activation option allows the user to activate only selected 
histograms. 

● When this option is activated, only the histograms marked as 
activated are returned, filled or saved in a file.

● Note that by default this feature is  not activated

● This feature is intensively used in extended/electromagnetic examples 
where all histograms are first created inactivated

● Then only selected histograms are activated in macros, using 
the analysis "set" command

G4AnalysisManager* analysisManager = G4AnalysisManager::Instance();
 analysisManager->SetActivation(true);
  // define histogram parameters name, title, nbins, vmin, vmax
  G4int id = analysisManager->CreateH1(name, title, nbins, vmin, vmax);
  analysisManager->SetActivation(G4VAnalysisManager::kH1, id, false);
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Histograms Properties

● The properties, additional to those defined in g4tools, can be added to 
histograms via G4AnalysisManager

● Unit: if a histogram is defined with a unit, all filled values are automatically 
converted to this defined unit and the unit is added to the histogram axis title.

● Function: if a histogram is defined with a function, the function is 
automatically executed on the filled values and its name is added to the 
histogram axis title. 

● The available functions: log, log10, exp .

● When a histogram is defined with both unit and function the unit is applied first.

● Activation: see previous slide.
● ASCII option: if activated the histogram is also printed in an ASCII file when 

G4AnalysisManager::Write() function is called. 
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Analysis Commands

gammaSpectrum.mac  in TestEm5

 
● A set of Geant4 commands which can be used to create 

histograms or set their properties dynamically
● They are implemented in G4AnalysisMessenger class 

● Commands for handling files, directories and general options

/analysis/setFileName name       # Set name for the histograms and ntuple file
/analysis/setHistoDirName name        # Set name for the histograms directory
/analysis/setNtupleDirName name      # Set name for the histograms directory
/analysis/setActivation true|false        # Set activation option
/analysis/verbose level                       # Set verbose level
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Analysis Commands (2)

/analysis/setFileName gammaSpectrum
/analysis/h1/set  3 200 0.01 10 MeV            #gamma: energy at vertex
/analysis/h1/set  5 200 0.01 10 MeV log10  #gamma: energy at vertex (log10) 
/analysis/h1/set 20 200 0 6 MeV       #gamma: energy at exit
/analysis/h1/set 40 200 0 6 MeV       #gamma: energy at back

● Commands to create or define 1D histogram:

● Commands to create or define 2D histogram:

● Example of a macro gammaSpectrum.mac  in TestEm5 

/analysis/h1/create 
   name title [nbin min max] [unit] [fcn]          # Create 1D histogram
/analysis/h1/set id nbin min max [unit] [fcn]   # Set parameters 

/analysis/h2/create                                         # Create 2D histogram
   name title [nxbin xmin xmax xunit xfcn nybin ymin ymax yunit yfcn] 
/analysis/h2/set                                              # Set parameters
   id nbin xmin xmax xunit xfcn nybin ymin ymax yunit yfcn  
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Analysis Commands (3)
● The commands for 1D histogram control: 

● The same set of commands is available for 2D histograms, under 
"/analysis/h2" directory.

/analysis/h1/setAscii id true|false     # Print 1D histogram on ASCII file
/analysis/h1/setTitle id title              # Set title for the 1D histogram
/analysis/h1/setXaxis id title            # Set x-axis title for the 1D histogram
/analysis/h1/setYaxis id title             # Set y-axis title for the 1D histogram
/analysis/h1/setActivation id true|false       # Set activation for the 1D histogram
/analysis/h1/setActivationToAll  true|false   # Set activation to all 1D histograms
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NtuplesB4RunAction.cc

#include "B4Analysis.hh"

void B4RunAction::BeginOfRunAction(const G4Run* run) 
{ 
  // Get analysis manager
  G4AnalysisManager* man = G4AnalysisManager::Instance();
  

  // Open an output file
  man->OpenFile("exampleB4");
  

  // Create ntuple
  man->CreateNtuple("B4", "Edep and TrackL");
  man->CreateNtupleDColumn("Eabs");
  man->CreateNtupleDColumn("Egap");
  man->FinishNtuple();
}

B4EventAction.cc

#include "B4Analysis.hh"

void B4EventAction::EndOfEventAction(const G4Run* aRun)
{
  G4AnalysisManager* man = G4AnalysisManager::Instance();
  man->FillNtupleDColumn(0, fEnergyAbs);
  man->FillNtupleDColumn(1, fEnergyGap);
  man->AddNtupleRow();  
}
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More On Ntuples

● Ntuple and Ntuple Column Identifiers
● In a similar way as for histogram ID, the ntuple and ntuple colum IDs are 

automatically generated when the ntuple or ntuple column is created by 
G4AnalysisManager::CreateNtuple() or 
G4AnalysisManager::CreateNtupleTColumn() and its value is returned 
from this function. 

● The default start value 0 can be again changed with the 
G4AnalysisManager::SetFirstNtupleId(G4int) method. 

● The ntuple column ID is not specific to the ntuple column type and its 
value is incremented in the order as the ntuple columns are created.
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Viewing/Processing
Resulted Files

● The analysis tool allow to fill histograms and/or ntuples and 
save them in files of supported formats:

● ROOT, XML, CSV, HBOOK

● Users Geant4 application need not to be linked with the external 
analysis tools in order to use the Geant4 analysis tool and 
produce the file(s) with histograms and/or ntuples

● But the analysis tools have to be installed on the users 
machines in order to view or process the analysis of the data in 
the generated files
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File Formats

● ROOT: 
● Can be view/processed with ROOT: http://root.cern.ch; which is able to 

process also the HBOOK and CSV formats

● XML (AIDA)
● JAS, iAIDA, Open Scientist Lab, rAIDA – see more details in the 

Appendix 2, in Geant4 Application Developer's Guide

● And “new” inlib/exlib:  http://inexlib.lal.in2p3.fr/

● CSV (comma-separated values)
● The simplest possible output format, can be analyzed by many tools

● Gnuplot, Excel, OpenOffice, ROOT

http://root.cern.ch/
http://geant4.web.cern.ch/geant4/UserDocumentation/UsersGuides/ForApplicationDeveloper/html/apas02.html
http://inexlib.lal.in2p3.fr/
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File Formats (2)

● HBOOK
● This format was defined in a Fortran callable package (HBOOK)  for 

histogramming and fitting which was developed in 1970~1990:

● PAW (Physics Analysis Workstation) - provides interactive graphical 
presentation and statistical or mathematical analysis of the HBOOK 
histograms/ntuples 

● Based on several components of the CERN Program Library

● Now fully superseded with ROOT

http://cernlib.web.cern.ch/cernlib/
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Analysis of Generated Files
With External Tools

Plotting ROOT files
... with ROOT
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ROOT

ROOT is a powerful analysis tools which provides 
● histogramming and graphing to view and analyze distributions and functions
● curve fitting (regression analysis) and minimization of functionals, statistics 

tools used for data analysis, 
● matrix algebra, four-vector computations, standard mathematical functions, 

multivariate data analysis, e.g. using neural networks,
● persistence and serialization of objects, which can cope with changes in 

class definitions of persistent data, creating files in various graphics formats, 
like PostScript, PNG, SVG

● 3D visualizations (geometry), image manipulation, used, for instance, to 
analyze astronomical pictures

● access to distributed data (in the context of the Grid), distributed computing, 
to parallelize data analyses, access to databases,

● interfacing Python and Ruby code in both directions, interfacing Monte Carlo 
event generators
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Viewing ROOT Files

● Start ROOT session

● Open a ROOT browser in the ROOT interactive shell

● See ROOT documentation
● How to edit histogram properties
● How to open Fit panel
● How to write ROOT macros

root [0] TBrowser b;            

$> root            
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Viewing ROOT Files (2)

File generated
In Geant4 
simulation

Selected H1
is automatically
drawn in the
canvas
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Analysis of Generated Files
With External Tools

Plotting CSV Files
GNUplot, Excel, Open[Libre]Office
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Plotting Csv with Gnuplot

24

 “Gnuplot is a portable command-line driven interactive data and 
function plotting utility for UNIX, IBM OS/2, MS Windows, DOS, 
Macintosh, VMS, Atari and many other platforms.”

 “The software is copyrighted but freely distributed 
(i.e., you don't have to pay for it).”

 http://www.gnuplot.info/

 At UNIX command line

$> gnuplot

plot mydata.dat

Note that files extension is .dat (and not .csv as generated from simulation) 

http://www.gnuplot.info/
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● Add info about External tools:
● ROOT, Tbrowser, Macro
● Csv – GNUplot, Excel, OpenOffice (Let's learn it !)
● XML – just links to the tools
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Plotting with Excel - 1

26

 Here are the instrctuons to import a .csv file into Excel

 From the “Data” menu, select “External Data”…“Import a text file…”

 Select the file

 The Text Import Wizard will come up

 Check the “Delimited” box

 Hit “Next”

 Check the “Comma” box

 The bottom part of the Wizard should now show your data nicely separated into appropriate columns

 Hit “Finish”

 You will see a dialog titled “Import Data” which will ask where to put the data.  Accept the defaults:

 Existing worksheet

 =$A$1

 Hit “OK”

 The data should now show up in the spreadsheet
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Plotting with Excel - 2

27

 Now that the data is in the spreadsheet, you 
can plot it as follows

 Select at least one item in the filled data area

 From the “Insert” menu, select “Chart…”

 Select Chart type: “Line”

 Hit “Finish”

 You’re done



28

Plotting with Open[Libre]Office - 1

28

 OpenOffice.org is a multiplatform and multilingual 
office suite and an open-source project

 LibreOffice is descended from OpenOffice, from which 
it was forked in 2010.

 Compatible with all other major office suites, the 
product is free to download, use, and distribute

 http://www.openoffice.org/ 

   http://www.libreoffice.org
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Plotting with Open[Libre]Office - 2

29

 From the “File” menu, select “Open…”

 In the “File type” box, select “Text CSV”
Note that this is NOT the same as just “Text”

 Then select your file
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Plotting with Open[Libre]Office - 3

30

 Once you select your file

 In the Text Import dialog, which will come up,  check the “Comma” box

 The bottom part of the dialog should now show your data nicely separated into 
appropriate columns.

 Hit “OK”

 The data should now show up in the spreadsheet.
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Plotting with Open[Libre]Office - 4

31

 Now that the data is in the spreadsheet, you can plot it as follows

 Select at least one item in the filled data area

 From the “Insert” menu, select “Chart…”

 The defaults should be fine

 Hit “Next”

 Select the
icon for “Line”
chart

 Hit “Create”

 You’re done
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Interfacing With 
External Analysis Tools

ROOT
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Examples With ROOT
● The Geant4 applications with use of ROOT classes are 

demonstrated in extended examples:
● analysis/AnaEx02 – demonstration of use of Root histograms and 

ntuples

– AnaEx01 – same with g4tools; AnaEx03 – same with  AIDA

– http://geant4.web.cern.ch/geant4/UserDocumentation/Doxygen/examples_do
c/html/Examples_analysis.html (link)

● persistency/P01, P02 
– Root I/O examples for storing and retrieving calorimeter hits (P01) and 

geometry objects (P02)
– Storing objects in a file using the 'reflection' technique for persistency 

provided by the Reflex tool
– The generation of the Reflex dictionary fails for Geant4 geometry classes 

using c-array with dynamic size declared via a variable of size_t type (as 
Reflex requires int)  and therefore saving the Geant4 geometry with ROOT 
I/O is currently not possible

– Reviewing these examples with changes for Geant4 MT 

http://geant4.web.cern.ch/geant4/UserDocumentation/Doxygen/examples_doc/html/Examples_analysis.html
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Interfacing With 
External Analysis Tools

AIDA Based Tools
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Examples With AIDA
● The Geant4 applications with use of AIDA based analysis is 

demonstrated in the extended example:
● analysis/AnaEx03 – demonstration of use of AIDA histograms and 

ntuples

– AnaEx01 – same with g4tools; AnaEx02 – same with ROOT

– http://geant4.web.cern.ch/geant4/UserDocumentation/Doxygen/examples_do
c/html/Examples_analysis.html (link)

● More extended/advanced examples with use of AIDA in Geant4 9.6.p01

– Now being migrated to g4tools
● This examples require to be build with an AIDA compliant analysis tools 

(OpenScientist, osc_batch, ...) 

http://geant4.web.cern.ch/geant4/UserDocumentation/Doxygen/examples_doc/html/Examples_analysis.html
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Using OpenScientist

36

 Detailed guidance on integrating with Geant4 
available at http://openscientist.lal.in2p3.fr 

 including support for using in Windows

http://openscientist.lal.in2p3.fr/
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Conclusions

● Since 9.5 release, Geant4 provides a lightweight analysis tools 
as part of distribution

● In addition users can choose to use external package 
functionality in applications' UserActions and link against 
libraries

● User communities have developed (or adopted) analysis tools 
suitable to their applications

● Geant4 Analysis Forum
● http://hypernews.slac.stanford.edu/HyperNews/geant4/get/analysis.html

http://hypernews.slac.stanford.edu/HyperNews/geant4/get/analysis.html

	Slide 1
	Slide 2
	Slide 3
	Slide 4
	Slide 5
	Slide 6
	Slide 7
	Slide 8
	Slide 9
	Slide 10
	Slide 11
	Slide 12
	Slide 13
	Slide 14
	Slide 15
	Slide 16
	Slide 17
	Slide 18
	Slide 19
	Slide 20
	Slide 21
	Slide 22
	Slide 23
	Plotting with Gnuplot
	Slide 25
	Plotting with Excel - 1
	Plotting with Excel - 2
	Plotting with OpenOffice - 1
	Plotting with OpenOffice - 2
	Plotting with OpenOffice - 3
	Slide 31
	Slide 32
	Slide 33
	Slide 34
	Slide 35
	Using OpenScientist
	Slide 37

